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Module 3 – Grading Workflow and Methods 
 

Note: This module was created with the assumption that both students and teachers have a basic 

understanding of site engineering, and working with contour lines to design a site’s grading.  
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Module 3 – Grading Workflow and Methods 

 

Part 1 – Creating a Topography from Model Lines 

• Assigning elevations to Model Lines - Set Elevation 

• Model Line settings in ‘Environment’ tools 

• Checking and labeling Model Line elevation - Check Elevation 

• Creating a topography from Model Lines - Create Surface 

 

Part 2 – Sloping a Floor according to a ‘help surface’ 

• Shaping (grading) a Floor by a topography - Shape by Topography 

• Hiding and revealing elements in a specific View - Hide in View by Element/by Category  

• Getting to know the Visibility Graphics Overrides settings for a specific View 

 

Part 3 – Implementing all of the different methods for creating sloped surfaces 

• Completing the slope design of simple paths using Modify Sub Elements 

• Manually changing points and snaping to model elements 

• Sloping curved paths using Shape by Topography 

 

Part 4 – Floor contours, Floor patterns and secondary surfaces 

• Adding contour lines and contour labels to Floors - Floor Contours + Check elevation 

• Modeling secondary surfaces with topographies using - Surface from Edge 

• Splitting a Toposurface - Split Surface 

• Correcting a deformation in a Floor’s pattern in a specific View - Object Outline 

 

Part 5 – Creating a section and editing graphic settings  

• Create a new section View – Section   

• Hide or reveal a section symbol on a plan View - Hide at Scale Coarser Than  

• Changing a section’s View depth – Far Clipping / Far Clip Offset  

• Changing a section’s View Scale 

• Hiding helper surfaces in a cross-section - Hide in View > By Element 

• Smart annotating - Spot Elevation 

• Showing a topography cut profile in a section View - Surface Profile 
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Exercise 3 

 

Part 1 – Creating a Topography from Model Lines 

 

In this exercise, we will use Model Lines as contours from which we will create a Topography.  

 

Creating a helper surface from Model Lines to grade the Floors: 

• Open the attached Module 03_Ex 01 file. 

• Switch to ‘Site General Plan’ View from the project browser. 

• Switch to the Wireframe display on the “View Control Bar” – This makes all model surfaces 

transparent, allowing you to see the reference picture we inserted for guidance.  

 

 

 

 

 

• Draw Model Lines to match the elevations in the reference image. You can draw them ruffly 

similar to the example below: (Remember these are only help lines for grading purposes). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tip: Use the Help Lines line Type. We created this line style especially for creating helper lines. These 

lines are meant to aid in the design but should not be included in the project documents.  
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If this line style is not currently visible in the View, open the Visibility Graphics Overrides window 

and turn on the “Help Lines” Sub-Category under the Lines Category.  

  

 

• Define an elevation for each line according to the reference plan, using the Set Elevation 

command under the Environment ribbon (don’t forget to hit the Enter key to actually set the 

elevation). Click on Set Elevation to execute the command. 

 

 

 

 

 

Tip: To set the elevation of a series of related lines, for example, the lines of an even slope, you can 

select the Set Elevation by Crossing option, under the Set Elevation command: 

- Enter the elevation of the bottom-most line (in reference to sea-level) in the “Elevation” field.* 

- Enter the desired vertical increment between each line in the “Increment” field.* 

- Draw a line across the contour lines whose elevation you would like to set. 

- Executing the command will set the elevation of the desired contour lines at the desired 

increments. 

 

How can we know if the command was successful? The Model Line we selected will change its color 

(in this specific View only). We can also go to the 3D View and see the change in elevation. 
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• Switch the visual style to Consistent Colors to preview the surface we will be creating. 

 

 

 

 

 

• Go to the Environment tab and open the Topography Tools window to create a new surface.  

• Select the Add Line tool and select all the relevant Model Lines (make sure to not select any of 

the other help lines we created). 

• Pick the Custom Settings option to adjust the number of elevation points added on each line. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Click on the Add Lines button to add elevation points along the selected Model Lines and hit 

Finish to exit the command.  
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• Now, we want to make sure that the helper surface covers all of the Floors for which we 

wish to create slopes with the aid of the surface. 

• Switch to top View or Floor Plan View. 

 

 

 

 

• Select the new topography and on the Modify tab, click on Topography Tools again to edit 

the surface. (Some actions are possible via the regular Edit Surface tool, however, All actions 

are available through Environment’s Topography Tools). 

 

 

 

 

 

Tip: Arrange the points in the direction of the 

topography lines to maintain a consistent 

slope. 

 

 

 

 

 

• Using the Move tool in the Topography Tools window, select and drag the relevant points 

to enlarge the surface so that it will cover all of the Floors without changing the slopes. 
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Part 2 – Sloping a Floor according to a ‘help surface’ 

 

In this exercise, we wish to create a topography as a help surface (reference surface) to aid in 

assigning slopes to the flat Floors we modeled as the exterior paths.  

 

• Select the surface and give it  a name in the Properties window 

under the ‘Name’ parameter.  This will allow us to identify each 

surface by its purpose later in the modeling process. 

 

 

• Switch to 3D View 

 

 

 

 

 

 

Drape a Floor over a help Toposurface using Shape by Topography 

 

• Select the topography and Floors and click on Environment > Shape by 

Topography (you can select the topography and the floors before or after 

starting the command). 

 

 

• Define the “Related Elevation” of the top of the 

Floor relative to the helper surface. In our case it’s 

0. 
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• Now, we’ll repeat the command in order to slope the 

road, but in this case, we’ll define an offset in the 

Related Elevation parameter, such that the road will be 

15 cm lower than the sidewalk. 

 

 

 

 

 

 

 

 

 

• Open the Visibility Graphic Overrides (VG) menu 

and turn off the ‘Help Line’ line style Category in 

this View.  

• Alternatively, you can right-click with your mouse 

on one of the lines, and click on Hide in View > 

Category. 

 

 

 

• Select the Toposurface and hide it in this View.  

 

 

 

 

 

 

 

 

 

Pay attention: When showing or hiding an element in a View, make sure you understand the 

difference between hiding a specific element and hiding an entire category.  
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Part 3 – Implementing all of the different methods for creating sloped surfaces 

 

Defining a Floor’s elevation using a Slope Arrow 

 

• Select the Floor and set its elevation to 5 meters 

above sea level. 

 

 

 

 

 

 

 

 

 

 

 

• Select the Floor and initiate the Edit Boundary command In the Modify ribbon. 

 

 

• Select “Slope Arrow” 

 

 

• Draw the Slope Arrow on the surface to indicate slope location and direction, as follows: 
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• Set the slope grade (percentage) 

Note: The Slope Arrow element accounts for the Height 

Offset from the Level assigned to the Floor and creates a 

slope according to the length and in the direction of the 

arrow. 

 

• Click the green checkmark to approve and exit the 

command. 

 

 

 

 

 

Slope a Floor by defining each and every elevation point 

 

 

 

 

 

 

 

 

 

 

• Place ‘Spot Elevation’ annotations over the four points where this path connects to the other 

paths, to indicate the elevation we should assign to its four corners. 
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Tip: Use the ‘TAB’ button to identify the Floor you wish to annotate. 

Continue pressing ‘TAB’ until the system identifies the correct Floor’s 

points. 

 

 

 

 

• Select the Floor and initiate the command for editing the points – Modify Sub Elements.   

 

 

 

 

 

• We can change the height of the pathway by selecting each point and assigning them elevations 

or by switching to 3D and changing a point’s elevation by selecting and dragging it using the 

arrows, until it attaches to the relevant Floor edge. 
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Note: When you set the elevation of the first point, Revit will display a warning that it has detected 

that the Floor’s slope is too steep. You can ignore this message, because the slope will work itself 

out once you set the elevations for all of the relevant points. 

 

 

 

 

 

• To create a sloped Floor for the rounded paths in the plan, follow the first method we described 

of creating a helper Toposurface and shaping the Floor on top of it. 

Draw the Model Lines according to the following image and set the lines’ elevations according 

to the plan. 

 

 

 

  

 

 

 

 

 

 

 

 

 

 



 

- 15 - 

© 2022 Arch-Intelligence Ltd. All rights reserved. 

 

MODULE 03 | EXERCISE 

 

 

• After shaping the Floor on top of the helper Toposurface, adjust the Floor’s elevation points 

with the ‘Modify Sub Element’ command, to connect it to the surrounding paths.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Switch to 3D to View the end result with sloped Floors. 
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Part 4 – Floor contours, Floor patterns and secondary surfaces 

 

Adding contour lines to the Floors: 

 

Note: In Revit, topographies can ‘naturally’ display their contour lines according to predefined 

settings. Floors, however, don’t have this feature, so we use an Environment feature to add smart 

Model Lines to the Floor face instead of contour lines. 

 

• Select all of the Floors within the model and select 

the “Slab Contours” command (you may also click 

on the command first, and then select the Floors 

and click ‘Finish’). 

 

 

 

• Define vertical distances / height intervals between the contour lines on the Floors and define 

line Types. 

  

 

 

 

 

 

 

 

 

 

• Add contour elevation labels to the lines – Check Elevation 

 

Tip: You can place elevation labels by manually selecting single lines or by drawing a line across a 

number of contour lines at once. 
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Secondary surfaces: Modeling the gardening areas with Toposurfaces. 

 

• Switch to 3D View 

 

• Select the “Topography Tools” command and pick the ‘From Edge’ tool to create a new 

topography. 

 

 

 

 

 

 

• Define a Height Offset as indicated in 

the image to create a surface 5 cm 

below the pathway. 

 

  

 

 

 

 

• Select the edges that you want to 

serve as the basis for creating the 

surface and execute the command. 

You can unselect an edge by clicking 

on it a second time. 

 

 

 

 

 

 

Tip: After we’ve selected all of the edges, we recommend enlarging the surface a little by selecting 

the ‘One Point’ option and clicking on points outside the surface boundary. This will help simplify 

splitting the topography later on. 
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• Switch to Floor Plan and split the topography based on the paths that define its boundaries.  

• Select the Split Surface command and then select the topography. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Change the topography’s ‘Material’ and ‘Name’. 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Repeat these actions to create the project’s western gardening area in the same manner. 

• Switch to the Site General Plan View. 
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• Because the Floors are sloped, their texture might be displayed as distorted. To correct this – 

we’ll turn off the Floors’ top texture and, in this View, we’ll create a two-dimensional texture 

that will cover the Floors and display a clean texture. Pay attention – this solution applies only 

to the specific View in question. 

 

 

 

 

 

 

  

 

• In the “Visibility Graphics” window, turn off the “Patterns” property for all of the Floors in the 

View. 

 

Tip: You can open the Visibility Graphics window by using the keyboard shortcut “VG”. 
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• Now we’ll create a new Pattern using the Object Outline command in the Environment tab.  

 

Note: Revit’s ‘Filled Region’ is a two-dimensional, View specific element. You can 

also create one via the Annotation ribbon, but the one you created using 

Environment>Object Outline will be linked to the Floor it was created from and will 

adapt as you edit the Floor’s boundaries.  

Environment creates a new ‘Filled Region’ Type to cover the Floorings, but it 

behaves as a separate element from the Floors. This means that we can delete it at 

any time, without deleting the underlying Floors. 

 

• Select all of the Floors and then select the command. 

 

Part 5 – Creating a Section View and controlling topography appearance 

 

• Go to the View tab and click on Section to create a new section View. 

 

 

 

 

 

• Draw the new section View as follows: 
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• Switch to the “Section 02” View from the project browser, or by selecting 

the section symbol in the current Floor Plan View, right-clicking on it and 

selecting “Go to View”. 

 

 

Important: When creating a new Section mark on a plan View, the Section 

View inherits its scale from the current Floor Plan View, thus the Section 

mark will not appear on plans with a scale greater than this. To change 

the appearance of a section symbol for larger scale Views, select the 

section and change the ‘Hide at scale coarser than’ Parameter. 

 

 

 

 

 

 

 

 

 

 

• In the section View, hide the project’s helper surfaces and help lines. 

 

You can identify a helper surface by selecting a surface and looking at its name in the Properties 

window. Then hide it in this View: 

 

 

 

 

 

 

 

 

Tip: At this point, the topography in this section View appears a lot deeper than the planned 

elevation. We can change this by opening the “Site Settings” window in the “Massing and Site” 

ribbon and changing the ‘Elevation of poche base’ parameter. 
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Module 4 – Placing and Creating Families 
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Module 4 – Placing and Creating Families 

 

Part 1 – Adding Families to your model 

• Adding Families to a model - Component  

• The Types of each Family 

• Placing a Family on a surface – Host surface 

• Adding new Families to a file – Load Family 

• Placement angle – using the space bar 

• Editing a Family – Edit Family 

• Changing the level of detail in a View – Detail Level 

 

Part 2 – Creating a new Family 

• Creating a new Family – Metric Generic Model 

• Setting a Category to a new Family  

• The Family workspace 

• Modeling a Family - Extrusion 

• Loading a Family to a file 

• Changing a Family’s or a Type’s name through Project Browser 

• Loading a Revit Family from Autodesk libraries 

• Getting to know Family download sites 

 

Part 3 –Scattering elements based on predefined parameters  

• Adding a rockery Family – Rockery Element 

• Arranging a line of rocks – Array 

• Scattering a row of bushes – Line Scatter 

• Attaching element elevations to surfaces – Align to Surface 

• Scattering a group of plants in an area – Area Scatter 
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Exercise 4 

 

Part 1 – Adding Families to your model 

 

Component → Components are all Revit Families with a defined 3D or 2D geometry that are used 

for purposes of building and representation in our project. 

 

Placing trees in the model and importing new Families 

 

• Open the Module 04_Ex 01 file, and switch to the Site General Plan View. 

• Add a new tree Family from the Massing & Site menu or the Architecture > Component menu. 

 

 

 

 

 

Tip: When placing a component in a model, Revit will automatically assign it the height 

of the surface on which we placed the element. This property is called “Host”, i.e., the 

hosting element. We can change the newly added element’s host by selecting it and 

clicking on “Pick New Host”. 

 

Tip: We recommend browsing through the various tree Families within the file – what parameters 

does each Family make available and how does each Family look in different Views and in different 

visual styles. 
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• Create a new Type of tree: select the tree component and click on the “Edit Type” button to 

open the Type Properties window. Within the window, select the Duplicate option. 

 

 

 

 

 

 

 

 

 

 

 

• Give the new Type a name and change the  

height of the tree and it’s radius (“Plan Symbol 

Size”). 

 

Tip: the height parameter is a built-in parameter for 

the planting Category. Other parameters, such as 

‘Plan Symbol Size’, depend on the creator of the 

specific Family. 

 

 

 

 

 

 



 

- 26 - 

© 2022 Arch-Intelligence Ltd. All rights reserved. 

 

MODULE 04 | EXERCISE 

• Next, go to the Insert tab and click on Load Family to add a new Family of trees to the file. 

Browse to select the following Family from the Module 04 folder. This Family presents different 

graphics and properties.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• To place the new Family within your model, click on the ‘Site Component’ menu from the 

Massing and Site ribbon, and select the Family from the list above the Properties palette. 

 

• Now we’ll create a new Type, similarly to the way we created a new Floor Type – Click on “Edit 

Type”, select “Duplicate” in the Type Properties window, and change the following parameters: 

  

Note: This Family has additional 

parameters that can be changed, because 

whomever created the Family decided to 

make these parameters changeable 

variables. 
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• Next, create a number of additional tree Types in the same way, and place them in your model 

as you see fit. 

• Arrange benches and trees within the model using the Architecture > Component command. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tip: To position components based on a guiding line within the model, select the Family you want to 

insert and hover over the edge or line without clicking on it. Press the spacebar a number of times to 

turn the component in the correct direction. 
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Loading people Families into the model 

 

• Open this lesson’s folder and find the following Family. Open the Family by double clicking it: 

 

 

Please notice that a Revit ‘Family’ file has been opened, and not a 

‘Project’ file. You can see that this is the case by the fact that the 

toolbar and the tools within are different than those we see when 

opening a project.  

 

• To load this Family into the file, click on “Load into Project”. 

• Now we’ll select the project into which we wish to add the Family, and we’ll place the people in 

the desired View. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tip: On the bottom toolbar next to “Visual Style”, you will find a button named “Detail Level”. 

Certain Family elements will be displayed differently when we change the View’s level of detail. 

How an element will respond when different levels of detail are applied, is, again, up to the 

element’s creator. 
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Part 2 – Creating a new Family 

 

Opening a new Family- Generic Model 

 

Attention: There are quite a few Types of Families you can create, and the topic is worthy of a 

course of its own. In this course we’ll learn a few basic actions to familiarize ourselves with the topic 

and that will provide us with the flexibility to work with other Families in the future. 

• Open a new file of Type Family (“.rfa” file extension). 

• Select the appropriate Template from Revit’s default lists - Metric Generic Model 
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Part 3 – Placing elements in the model: Array and Scatter 

 

Placing a row of rocks using the Array command 

 

• On the Environment tab, select the Rockery Element command in order to 

import a Family of rocks into the model. 

• Select one of the rock Types and import it into the model. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Lay the first rock in the corner nearest to the road, select it, and click on the Array command 

(before placing the rock on the topography, hover over the sidewalk’s edge and use the 

spacebar to align the rock with the pathway). 
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• Use the following settings and create the row of rocks. 

 

 

 

• Next, click once at the edge of the first rock and click again at the edge of your planned row of 

rocks to set the desired row length.  

 

Tip: We can also use Group and Associate to edit the number of rocks in the group after exiting the 

command. 

 

• Repeat this process to create an identical row of rocks on the other side of the pathway. 
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Modeling a row of shrubs using Line Scatter on the Environment tab 

 

• Select a Family of bushes and create three different Types of vegetation. 
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• Switch to the ‘Site General Plan’ and select the Line Scatter command on the Environment tab. 

 

 

 

 

 

 

 

• This displays a window in which we will select “Draw Path” and draw a continuous path on 

which to position the bushes. 

• After completing the sketching, click on Apply Path 
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• Select the desired Type and enter placement settings. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Arrange a similar row of bushes on the other side of the path. 
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Modeling groups of mixed vegetation using Area Scatter 

 

• Select the Area Scatter command under the Environment Tab. 

 

 

 

 

 

• Next, select any surface to set the surface on which to scatter the elements. 

You may choose any surface to be used as the area for the scatter command. 

 

 

 

 

 

 

 

 

 

 

• Create a mix of elements. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Define the placement of the elements in an orderly grid. 
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• Continue to scatter vegetation and additional elements as you see fit. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 




